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INTRODUCTION
This costing guide will cover the basics of FM3’s accounting functionality, including Job Costing, creating 
an Invoice, adding a Purchase Invoice, generating Bulk Invoices and editing an invoice. The Sigma 
Support Team are here to advise further.

Checks
Before raising an invoice, it might be worth completing some checks to minimise the risk of problems 
down the line.

Account Numbers
Ensure account codes (Sales A/ C No) are in the address entries needed for this invoice (Database > 
Address Editor > Search and select the code > Accounts).

 Database > Address Editor
 Address Editor > Listing View (Accounts Tab 

Highlighted)

 Address Editor > Accounts Tab
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Invoice Frequency [Bulk Invoice Only]
When creating a Bulk Invoice across multiple jobs, “Invoice Frequency” 
will determine how many invoices are created.

For example, if the Invoice Frequency is set to “Per Job”, this will create 
individual invoices for each job within the selected charges. However, if 
“Daily“, “Weekly”, “Monthly” or “Quarterly” are selected, these will 
group the invoices by the chosen period (Day/ Week/ Month/ Quarter).
If “Consolidated” is selected, you can keep entering charges and raising 
them into the same invoice.  That is to say, the first job you enter 
charges for will result in invoice “X”.  If you enter charges into another 
job for that client and raise them, they will be placed onto the same 
invoice, not a new one.  You can keep doing this until the invoice is 
“printed” or the batch it belongs to is closed. This frequency allows you 
to control charges for a customer to issue the invoice when you feel 
appropriate, or should none of the time interval related frequencies 
listed above apply.

 Address Editor > Accounts 
Tab

Rate of Exchange
Check the ROE (Rate of Exchange) through Database > Currency. Search the currency code, click the 
‘Details’ tab, check if there is a line in the grid and add one if there is not (May require approval/
permission from a manager).

 Database > Currency

 Currency > Search For [Details Tab Highlighted]

 Currency > Details Tab [ROE Grid Highlighted]  Currency > Details Tab [ROE Line]
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 Job > Document Status  Job > Enter Charges Button

 Job Costing

JOB COSTING
Within every job, there is a ‘Costing’ page. This page will contain financial information relating to the 
chosen job, ranging from Sales Lines and Invoices to Accruals and Purchase Invoices.

Document Status

Click the ‘Document Status’ then ‘Costing’ entry in 
the listing.

Side Menu

The ‘Enter Charges’ button also brings you to the 
Costing page.

Costing Page
The page is split into 3 sections: ‘Sales’, ‘Accruals’ 
and ‘Actuals’. 
'Sales' charge lines are the ones you expect to 
charge your client for the job, so you will raise 
these into “Invoices” or “Credit Notes” (or even 
“Duty/VAT invoices” and credit notes if you want 
to generate them).  
'Accruals' are the costs you expect to be charged 
by your suppliers for work relating to this job.  
These will eventually be converted into “actuals” 
when you receive an invoice from your supplier 
(which you would enter via the “Purchase 
approval” function discussed later on).

Entering charges into either grid involves the same process – at the bare minimum, you should enter an 
address code, a charge code, and an amount to be charged, for each charge line.  You can optionally 
enter more details, such as currencies to charge and invoice, but you don’t need to if you don’t have to.
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Field Description

ChgCurr This is the currency you are charging in

ChgROE The ROE between the Charge currency and the Invoice Currency (below)

InvCurr The currency you wish to invoice this charge out as

InvAmount The amount that will be shown on the invoice

HomeROE The ROE from the Charge Currency to the Home Currency

HomeAmount The charge amount is converted to your home currency, and shown here

HomeCurr The home currency code

Charge Notes Any other details you wish to enter for the charge line – limit of 255 characters

Type Determines whether you are raising an Invoice or a Credit note

VatCode How much VAT is to be charged for this line, depends upon this code

VAT The amount of VAT, determined by the Home amount and the VAT Code

CreatedBy The login name of the user who entered this charge line

Created When this charge line was entered

Batching
The ‘Batch’/'Unbatch'
buttons are within the 
Sales section of the Costing 
page. These buttons are 
used to ‘batch’ a Sales line 
and mark them as ready 
to raise. When creating 
invoices, this difference will 
come in handy to ensure 
that only batched/ready 
lines are raised. Batched 
lines will be highlighted in 
light purple.

 Job Costing > Batch Buttons

 Job Costing > Charge Lines
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SALES INVOICE
Sales Invoices can be generated from within the Sales section on the Job Costing page. All invoices 
created within FM3 are accessible, to view or print, from Sales View.

Sales in Job Costing
You can raise lines directly into invoices within the Sales grid with the ‘Raise Line’ buttons.

 Job Costing > Sales Section

Add Charge Lines
Within the ‘Charges’ tab in Job Costing, add a charge line by selecting one of the field boxes (either 
Client or ChgCode would be a good place to start). You can’t interact with the InvNo box as this will be 
automatically filled in once the line has been raised or with ‘ChgDesc’ which will be filled in once a 
ChgCode (Charge Code) has been selected. Invoice Date will auto-fill to the date the line is created, 
however, it can be edited if needed. ChgAmount is the charge amount of the line, this can be entered 
into the field or calculated by filling out the Quantity (Qty) and UnitPrice fields. Rate of Exchange (ROE) 
fields, such as ChgROE and HomeROE, will dynamically change depending on the Currency chosen 
(ChgCurr, InvCurr and HomeCurr). The ChargeNotes field is where you can note any additional 
information related to this charge line. Invoice Type notes if this line is an ‘Invoice’ or a ‘Credit Note’, this 
should be a dropdown for you to choose from. VatCode will also need to be added, the VAT field will 
then be calculated and populated with the monetary amount depending on the code chosen (e.g. if the 
code ‘Z' is chosen, this usually means the VAT will be 0% and therefore £0, whereas, 'S20’ usually means 
the VAT is at 20% so if the charge line is £100 then the vat would be £20).

The tab button on your keyboard can be used to move from one box to the next and to save a line, tab 
to the next line, either press down ↓ then up ↑ on your keyboard or click the small tick in the top 
toolbar.

Raise Lines to create an Invoice
Depending on how many lines need to be raised 
at one time, to one invoice, you can select ‘Raise 
Line’ which will batch then raise the selected line 
or ‘Raise All’ which batches and raises all lines 
into a single invoice.

 Job Costing > Raise Line Buttons
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Using either of these 
buttons will open the 
‘Invoice Generation 
Wizard’. Since this was 
opened within Job Costing, 
the Job Number will be set 
and made Read Only. 
‘Batch Assignment’ will 
determine which batch this 
invoice sits in, ready for 
transmission to your 
accounts package (if 
configured). Unless 
amended manually, ‘Tax 
Point Date’ will 
automatically be set to the 
current date. Finally, select 
‘Next’ to move on to the 
next page.

 Job Costing > Raise Line > Invoice Generation Wizard

The following page requires you to select the lines you want to turn into an invoice. Click the '+' on the 
left-hand side to expand the line options.

 Job Costing > Raise Line > Invoice Generation Wizard [Expand Lines]
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 Job Costing > Raise Line > Invoice Gen Wizard [Line Unticked]

 Job Costing > Raise All > Invoice Gen Wizard [Line Ticked]

Depending on which 
button you selected, the 
lines batched and raised 
will be combined to be one 
invoice. In this example, 
‘Raise Line’ has raised the 
single line as £59 whereas 
‘Raise All’ has combined 
the lines of £59, £27 and 
£16 to make an invoice of 
£102. You will need to tick 
which lines you’d like to 
raise before moving to the 
next page.

A summary of your selection will allow you to check the information chosen before finally generating 
the invoice with the ‘Generation’ button to the right.

 Job Costing > Invoice Gen Wizard [Generate 
Invoice Button Highlighted]

 Job Costing > Invoice Gen Wizard [Confirm 
Invoice Generation Highlighted]
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Now that the invoice has 
been created, you will be 
given its Invoice number 
within the ‘Invoice 
Generation Results’ page. 
From here, you can close 
the window and continue 
working on the job, or you 
can hit ‘Print Now’ which 
will take you to ‘Sales 
View’ (see below for more 
details) to print.

 Job Costing > Inv Gen Wizard

Sales View
You can search and view all 
invoices within FM3 via the 
‘Sales View’. To access this, 
select the ‘Accounts’ menu 
in the top toolbar, move to 
the ‘Sales’ sub-menu and 
then ‘Sales View’.

 Accounts Menu > Sales Sub-Menu > Sales View

 Sales View

Fields across the top are available to search, most are self-explanatory, but ‘Search For’ and ‘Search In’
depend on one another. ‘Search In’ will allow you to select a range of fields to use within your search. 
You will then need to type the specific data in the ‘Search For’ field, for example, to look up a certain 
invoice number you would need to select “No” in ‘Search In’ and type the number (i.e. INV000014) in 
‘Search For’.
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 Sales View > Search [INV000014]

Additionally, you can specify which dates you are looking for with the ‘Search Date’ dropdown. This will 
set the type of date whereas the ‘Date From’ and ‘Date To’ date pickers select the dates to search on.

 Sales View > Search [Date Dropdown]

Sales View also allows you to view the details of 
each invoice via the togglable tabs; ‘Listing’ and 
‘Invoice Details’. ‘Listing’ displays all invoices 
that meet the search criteria, if there are no 
criteria it will show all invoices in the system. 
‘Invoice Details’ expands on the chosen invoice 
to show more detailed information, such as the 
invoice lines.  Sales View [Tabs Highlighted]

 Sales View > [Listing Tab]
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 Sales View > [Invoice Details Tab]
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PURCHASE INVOICE
Before a Purchase Invoice can be added to FM3, first, it will need to be added, against the correct job, 
as an accrual line. These accruals will be raised and an estimate left in its place (only visible in the ‘All 
Transactions’ tab of Costing).

Accruals in Job Costing
(Also known as Quick Approval)

Accruals can be approved straight from the Job Costing page using the ‘Approve’ button. Ensure you 
select the Accrual line you want to approve before clicking the button.

 Job Costing > Accruals Section

‘Costing - Quick Approval’ 
should then appear and 
require some input. First, it 
will need the invoice 
number, date, currency, 
and type. These can all be 
added through various text 
boxes or dropdowns along 
the top of this pop-up 
window.

Secondly, the charges 
related to this invoice will 
need to be selected.

If multiple accruals are 
present, all will be listed, as 
long as they are from the 
same supplier.

Click ‘Next’ to continue.

 Job Costing > Quick Approval

 Job Costing > Quick Approval

To approve accruals from another supplier, continue with this approval and select the other line 
when back on the Costing page.
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Before finally approving 
the Purchase Invoice, FM3 
will display a summary for 
you to check over the 
information.

This is also where you can 
select which transfer 
batch this Purchase 
Invoice should be in.

To finalise and approve 
the Purchase Invoice, hit 
the ‘Finish’ button.  Job Costing > Quick Approval

Lastly, a pop-up will display 
the Folio and Batch 
number for your 
reference.

 Job Costing > Quick Approval

Going back to the job, the line we have just approved will now show as an 'Actual'.
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 Job Costing > Actuals & Actuals Sections

The ‘Accrual’ has now been converted into an Estimate and is only visible within the ‘All Transactions’ 
tab.

 Job Costing > All Transactions Tab

Purchase Invoice View
Another way to approve Purchase Invoices is through the ‘Purchase Invoice View’.
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To access this view, open 
the ‘Accounts’ menu, 
follow through to the 
‘Purchase’ subfolder and 
select ‘Purchase Invoices’.

All Purchase Invoices 
stored within FM3 will be 
displayed on this page.

 Accounts Menu > Purchase > Purchase Invoices

Search options are available on the Listing page and only invoices which match the full criteria will 
show.

 Purchase Invoices > Search & New Invoice

From the main ‘Purchase Invoice View’ page, you can create a new Purchase Invoice. Click ‘New 
Invoice’ to open the generation wizard.

New Purchase Invoice
Using this process of Purchase Invoice generation; you can create a Purchase Invoice from scratch. 
After selecting ‘New Invoice’ on the ‘Purchase Invoices’ page, a ‘Purchase Approval’ Wizard will 
appear (as seen below). The 3 main areas, which we will look into, are ‘Header’, ‘Charges’ and ‘Partial 
Aprroval’. The ‘Header' holds top level information about the invoice, such as Invoice ‘Amount’, 
'Date' and ‘Invoice From' (Who the invoice is from/ the supplier).
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 Purchase Invoices > [New Invoice] > Purchase Approval > Header

Invoice From
This field has an address 
picker which will allow you 
to select who the invoice is 
from (the supplier), out of 
the addresses listed in 
FM3. When looking for an 
address, you can use the 
‘Code’, Company ‘Name’
and ‘Country’ to search, 
however, be default only 
Addresses marked as 
‘Supplier’ will appear due 
to the 'Show only 
Supplier’ box being ticked. 
If the address you are after 
does not show, try 
unticking this. If you still 
can’t find the address code 
for this invoice, you can 
use the ‘New’ button to 
add another address 
straight to FM3 Addresses.

When an address is 
selected, the fill 

 Purchase Invoices > [New Invoice] > Purchase Approval > Header 
['Invoice From' Picker]
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information will be pulled 
through and shown in the 
grey box below the
‘Invoice From’ field.

 Purchase Invoices > [New Invoice] > Purchase Approval > Header [Filled 
In ‘Invoice From’]

Type
Options as to what kind of invoice this is are stored within the ‘Type’ dropdown.

‘Purchase Credit' and ‘Purchase Invoice’ are 
the same as those within Costings. ‘Purchase 
Invoices’ are costs to you, from your suppliers 
and ‘Purchase Credits’ are credits issued to you 
by suppliers. However, ‘Self Bill’ refers to a 
method of invoicing in which the customer (in 
this case, you) would prepare the invoice and 
send it with payment before the supplier sends 
the invoice.

 Purchase Invoices > [New Invoice] > Purchase 
Approval > Header [Type Dropdown]

Invoice Number and Date
Additional fields are ‘Invoice Number’ and ‘Date’. ‘Invoice Number’ refers to the unique number 
given to the invoice and ‘Date’ is the date of/on the invoice.

 Purchase Invoices > [New Invoice] > Purchase Approval > Header [Invoice Number And Date]

Monetary fields
The right side of the ‘Purchase Approval’ pop-up allows you to input the monetary details of this 
invoice. Only a few fields are required within this section, as the rest will be calculated or pulled in. 
‘Currency’ can be selected within the picker, options will be brought in from the ‘Database’ > 
‘Currency’ page. Once a ‘Currency’ is chosen, the ROE will be brought through and changed depending 
on each currency’s configuration. ‘Invoice Amount’ is the value of the invoice. To add VAT, you can 
select a VAT Code with the dropdown and the VAT will be calculated for you.
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 Purchase Invoices > [New Invoice] > Purchase 
Approval > Header [Empty]

 Purchase Invoices > [New Invoice] > Purchase 
Approval > Header [Filled In]

Assign Accruals
Once the header information is complete, select ‘Next’. The next page will allow you to search for and 
select the corresponding charges, for this invoice, from the jobs or add ones if they have not been 
created yet.

 Purchase Approval > Charges
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To find the charges, click ‘Search’ and use the fields to create a search criteria. The ‘Supplier Code’ will 
be auto-filled with the address code from the Invoice header section of this Purchase Invoice creation.

 Purchase Approval > Charges > Search

Accrual Type will also default to ‘Accrual’ but ‘Credit Accrual’ is also an option within this dropdown. 
You can also select the order in which results will be shown.

 Purchase Approval > Charges > Search [Accrual 
Type]

 Purchase Approval > Charges > Search[Order By]

Once the search criteria is as needed, click ‘Next’ to bring up the search results. Only a key fields will be 
displayed in the ‘Accrual Search Results’ page, including ‘FileRef’, ‘Supplier’, ‘ChgCode’ and 
‘ChgAmount’.
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 Purchase Approval > Charges > Accrual Search Results [No Selection]

 Purchase Approval > 
Charges > Accrual Search 

Results [One Selected]

If you can not find the accrual line you are after, you can add one using the ‘+' button beneath the grid 
in the ‘Charges’ grid then add the information as you would within Job Costing.

 Purchase Approval > Charges [Grid]

Note: When using the 
picker to search for a 
FileRef/Job you will need to 
hit the ‘Refresh’ button to 
apply the criteria.  Purchase Approval > Charges Grid [File Ref Search]
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 Purchase Approval > Charges [Grid & Totals]

The bottom section of this page shows you how the charges selected fit into the invoice amount, all 
charges must add to the amount specified in the Invoice header. ‘Total Home Amount’ shows the 
Invoice header home amount compared to the ‘Assigned’ charges and ‘Total Vat’ displays the header 
VAT versus the ‘Assigned’ VAT. The ‘Balance’ field is the difference between the Invoice header total and 
the total of the assigned charges, if this is above 0 the invoice can’t be generated and will only be 
‘Partiall Approved’ (see below).
The final page will display either a big tick if the amount match, or a big red cross if the charges 
assigned don’t match the amount of the invoice header.
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 Purchase Approval > Approval [Final Page - 
Matched]

 Purchase Approval > Approval [Final Page - 
Unmatched]

Partially Approved Invoices
If the charges related to an invoice don’t match, the invoice will be ‘Partially Approved’, marking them as 
incomplete. ‘Yes’ will take you to the Invoice within the ‘Purchase Invoices’ page and ‘No’ will take you 
back to the ‘Approval’ page (where you can select ‘< Back' to move to the previous page).

 Purchase Approval > Charges > Approval [Final Page - Unmatched - Partially Approve]

When back in the Purchase Invoices page, on the ‘Invoice’ tab, to go back and add/edit the charges 
select the ‘Edit’ button in the bottom left.
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 Purchase Invoices > Invoice [Partially Approved Invoice]

This will open the 
‘Purchase Approval' pop-up 
again, starting with the 
header, however, this time 
the fields available to edit 
will be limited. The 
‘Supplier Code’ (Invoice 
From), ‘Type’ and 'Invoice 
Number’ will be read-only.

Click ‘Next' to move to the 
‘Charges’ page. The rest of 
the process will be the 
same as when creating the 
invoice.

 Purchase Invoices > Invoice Tab > [Edit Button] > Header
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BULK INVOICE

We have an additional User Guide which covers Bulk Invoices in more depth/detail. 
Please ask for a copy if required, this guide will only give a short overview.

Before creating a Bulk Invoice, ensure clients are configured with an Invoice Frequency within the 
Address Editor entry.

Raising a Bulk invoice will group multiple lines 
from across jobs and raise them as one invoice. 
Bulk invoices can be created via the Invoice 
Generation tool under Accounts > Utilities. 
Before creating a Bulk Invoice, all charges
required within the invoice will need to already 
be on the corresponding job(s) and batched.

 Accounts Menu > Utilities > Invoice Generation

To raise a bulk invoice, you 
will need to search for the 
charge lines through one 
of the “Charges to 
generate” options. “All 
pending charges” will find 
any charges on any job 
within FM3. “A single file 
reference” will look for 
charges on a specific job.
“An address code” will 
search for all charges with 
this address code. 
Additionally, “Charge 
Search options” adds a 
date range criteria to the 
charge line search.

 Invoice Generation Wizard > Wizard Tab > Generation Mode

Within this first page, you can also assign a batch and set a tax point date. If left, the Batch Assignment 
will default to ‘Automatic batching’, which places the invoice in the oldest open batch or creates one if 
no batch is open. Additionally, the ‘Tax point date’ will default to today's date. Press ‘Next’ to search for 
the charges.

https://sigmafreightsystems.atlassian.net/wiki/spaces/UG/pages/edit-v2/3315335181#Invoice-Frequency-[Bulk-Invoice-Only]
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The following page will 
show all charge lines which 
meet the set criteria. You 
will need to expand the 
search results with the 
small '+' box found on the 
top line (as highlighted in 
the screenshot). Use the 
tickbox to select the 
required individual charge 
lines or the top tickbox to 
select all and, once 
complete, hit ‘Next’.

 Invoice Generation Wizard > Wizard Tab > Invoices To Generate

Finally, ‘Summary Totals’ 
displays all charge lines 
previously selected for you 
to check before generating 
the invoice. If this looks 
incorrect, you can go back 
with the ‘Back’ button and 
readjust the selected 
charge lines or search 
criteria. However, if the 
charges look correct, click 
the ‘Generate’ button to 
create the Bulk Invoice. A 
final pop-up will appear 
asking you to confirm you 
wish to create the invoice, 
if you select ‘Yes’ the 
invoice will be generated.

 Invoice Generation Wizard > Wizard Tab > Summary Totals

The allocated invoice number will be shown in ‘Invoice Generation Results’. From there, you can click 
‘Print Now' to print from Sales View or exit the pop-up to return to where you were before creating the 
Bulk Invoice.
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 Invoice Generation Wizard > Invoioice Generation Results
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EDITING AN INVOICE

An in-depth Guide on Invoice editing is available, this document will provide a short overview.

Invoice Editor is accessible via the ‘Accounts’ in 
the top menu, follow it down to ‘Utilities’, then 
across to ‘Invoice Editor’.

To find an invoice, you will need to know the 
‘Type’, ‘Address Code’ and ‘Invoice Number’. 
‘Type’ refers to the kind of invoice (e.g. Invoice, 
Purchase Invoice, Credit Note etc.). ‘Address 
Code’ will be the client code against the invoice 
and ‘Invoice Number’ is the allocated number.

 Accounts Menu > Utilities > Invoice Editor

 Invoice Editor

Click ‘Find Invoice’ to search for this invoice within FM3 Invoice Editor. ‘Header Details’ tab allows you 
to edit the header information of your selected invoice, such as, ‘Address Code’, ‘Invoice Date’ and the 
Batch it sits in. Some fields are unable to be edited (e.g. the invoice ‘Type’), if this information needs 
to be edited, you should create a Credit to balance the invoice and raise another one. Fields here will 
autosave when edited.
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 Invoice Editor > [Find Invoice] > Header Details Tab

Alternatively, the ‘Line Details’ tab gives you the ability to edit the charge lines within an invoice, this is 
done the same as job costing. To save line changes press the green tick in the bottom toolbar.

 Invoice Editor > [Find Invoice] > Line Details
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ADDITIONAL HELP
If you need additional guidance, please get in touch with us via email or telephone.
Tel: +44 (0) 330 223 5813
Email: helpdesk@sigmafreight.com
Website: https://www.sigmafreight.com/support/

mailto:helpdesk@sigmafreight.com
https://www.sigmafreight.com/support/
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